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Why do I want it?

To build a searchable and categorized 
database of all my references
To record the bibliographic information 
required for reference lists
To import bibliographic information from 
online searches
To format and maintain my citations and 
reference lists in documents I create
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Where can I get it?

Endnote Student Edition 7.0 (just released!)
Andrews Bookstore - $109.95

Call Ruth on 471-6500 for overnight delivery to Bookstore

Amazon.com - $94.99 plus shipping (version 6)
http://www.endnote.com/
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How do I use it?

1. Getting Started
2. Customizing Initial Settings
3. Entering Data Manually
4. Importing Data
5. Searches
6. Advanced Topics
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1. Getting Started

What is EndNote?
The Guided Tour
Installing the macros and toolbar

What is a library?
What is a “Reference Type”?
Create a Library

1. Getting Started

 

What is EndNote?  the complete reference solution! 
• EndNote is an online search tool—it provides a simple way to search online bibliographic 

databases and retrieve the references directly into EndNote. EndNote can also import data files 
saved from a variety of online services, CD-ROMs, and library databases. 

• EndNote is a reference database and image database. It specializes in storing, managing, and 
searching for bibliographic references in your private reference library. Now you can organize 
images including charts, figures, and equations with a caption and your own keywords. 

• EndNote is a bibliography maker and manuscript maker. It formats citations and figures in 
Microsoft Word with the Cite While You Write technology. Watch the bibliography and figure 
list appear as you insert citations in your manuscript. New Microsoft Word templates guide you 
through the exacting manuscript requirements of publishers. 
 
You can also create bibliographies using RTF Document Scan with other word processors. 
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The Guided Tour 
This short seminar can only show you some of the features of EndNote.  To become proficient in using 
the software, you must practise using the software.  The EndNote documentation includes a Guided Tour 
that is well worth taking.  I have included the Demo Version 7 Guided Tour on the session website, as 
well as some good “getting started” tip sheets, taken from the EndNote website. 
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Installation 
When you install EndNote, you will get a new toolbar in Microsoft Word supported by some macros. 
 
Show the new toolbar 

• Find Citation(s) 
• Go to EndNote 
• Format Bibliography 
• etc 

What is a Library? 
An EndNote library is a collection of references, each containing the information required to create a 
bibliography. Additional information such as keywords, notes, and abstracts can also be stored in these 
references. In addition to the reference data, the library contains indexes that are used to speed searching 
and sorting, and Term Lists, which facilitate the entry of commonly used words. 
 
References in the library are organized into fields. The fields that appear in a reference are determined by 
the reference type. 

• Each reference in a library can contain up to 64,000 characters, and any field can contain up to 
32,000 characters. 

• There is no limit to the number of libraries you can create. 
• Libraries can be set as “default libraries” that open automatically when EndNote is started. 
• You can have more than one library open at a time. 
• Libraries created with EndNote on one platform (Macintosh or Windows) can be used with 

EndNote on any other platform.  
• Each library is a separate file that can be independently moved, copied, renamed or deleted. 
• Your library can contain images, which are stored in a [library name].DATA folder that is placed 

in the same folder as your library. 
 
Important!  Each EndNote library can reach a maximum size of 32 MB or a maximum record number of 32,767 (whichever 
comes first). Once a record number is assigned, it cannot be used again in that library. So, if you import 30,000 records, then 
delete all but 1000 of them, you cannot enter even 3000 more records into that particular library. When importing records, we 
recommend that you import into a temporary new database, determine which ones you want to keep, then move those records 
into your permanent library. 
Copyright Thomson ISI  2003 

Reference Types 

What is a Reference Type? 
Your EndNote library can contain references from a variety of different sources, such as books, journal 
articles, and newspaper articles. We call these different sources reference types. EndNote provides built-
in forms for these and other common reference types.  
 
In addition to an all-encompassing “Generic” reference type, EndNote has three unused reference types 
and 25 pre-defined reference types: Journal Article, Book, Book Section, Manuscript, Edited Book, 
Magazine Article, Newspaper Article, Conference Proceedings, Thesis, Report, Personal Communication, 
Computer Program, Electronic Source, Audiovisual Material, Film or Broadcast, Artwork, Map, Patent, 
Hearing, Bill, Statute, Case, Chart or Table, Figure, and Equation. See: Default Reference Types for a 
table of reference types and fields. 
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Important Points About Reference Types 
• You can assign a particular reference type to each reference entered into your library.  
• The Reference Types table, accessible through EndNote’s Preferences, determines which fields 

are available for each of the different reference types. 
• The Reference Types table allows up to 29 different types of references, each capable of 

supporting up to 40 fields.  
• Of the 29 reference types, all but the Generic type can be modified.  
• Use the Reference Types table to add, delete, or rename fields. You can also add or remove 

complete reference types. 
• The layout of the Generic reference type should be used as a guide when modifying or creating 

reference types. Rows reserved for Authors should only be used for names. 
• Changes made to the Reference Types table are stored in the Windows system registry. They 

apply to all libraries opened on that computer.  
• If you move your library to a different computer, your references will follow the layout of the 

Reference Types table on that computer.   
• Do not enter reference data into the Reference Types table. This table is designed to store just the 

names of the reference fields. 

Reference Types and Data Entry 
The chosen reference type specifies which fields appear in the Reference window. For instance, an 
EndNote journal article reference includes the fields “Journal,” “Volume,” and “Issue,” while a book 
reference includes fields such as “Publisher” and “City.” The Reference window only displays the fields 
that are relevant to the chosen reference type. 
 
It is best to select the reference type before entering the bibliographic information in a reference. 
However, you can change the reference type of a reference at any time using the Reference Type menu 
list at the top of the Reference window. 

Relationship Between Reference Types and Styles, Filters, and Connections 
Styles, filters, and connection files can include templates for all of the different reference types. This 
enables various types of references to be formatted differently in a bibliography or imported differently, 
as necessary.  
 
The reference types and fields available to you when editing a style, filter, or connection file depend on 
how the reference types are configured in the Reference Types table. These files update automatically to 
reflect changes made in the Reference Types table (such as changing the name of a field). 

Customizing Reference Types 
The Reference Types table displays all available reference types and the fields that each reference type 
contains. Use the Reference Types table to add, remove, or rename fields—or to add a completely new 
reference type. 

To access the Reference Types table: 
1. From the Edit menu, choose Preferences. 
2. Click the Reference Types option in the list of preferences. 
3. Click the Modify Reference Types button and the Reference Types table will open. 

 
The Modify Reference Types command is enabled only when all Style, Filter, Connection, and Reference 
windows are closed.  
 
Copyright Thomson ISI  2003 

UsingEndnote.doc  Page 6 of 13 



Create a Library  (demonstrate all these steps) 
1. In the EndNote drop-down File menu, choose New… 
2. Choose a directory and a file name in the Do not use the default location in Program Files – 

place it somewhere in My Documents. 
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2. Customizing Initial Settings

Set the default Library
Set default Reference Type
Create Custom Fields
Set display font size
Set columns to display
Sorting the library entries

2. Customizing Initial Settings

 

Set the default Library (demonstrate all these steps) 
1. Drop-down menu Edit -> Preferences. 
2. Select Libraries in the list on the left. 
3. Click Add Open Libraries then click Apply. 

Set default Reference Type 
1. While in Edit Preferences, click on Reference Types in the list on the left. 
2. From the Default Reference Type drop-down box, choose Book or Journal Article 

or the type you will use most often and click Apply. 
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Create Custom Fields 
1. With Reference Types still selected, click the Modify Reference Types 

button. 
2. Scroll down to Custom 1. 
3. For each Reference Type this will apply to, type in the name of the custom field. 
4. Click OK when done. 

Custom fields I use: 
Two important custom fields that I use quite a lot are Shelf and Competence 

• Shelf – The category of book in my bookcase.  I have one for IT books and one for Leadership 
books.  I use EndNote and Word to print a catalog of books I should have in my bookcase, 
arranged by title and year, and this is helpful from time to time to check that I can account for all 
my books. 

• Competence – This field is absolutely vital for building the reference lists for the competencies 
and for the dissertation.  I can tell Endnote to list all the entries in my database for competency 
4(c), copy the selected entries into Word, and it formats the Reference List for me. 

• A new feature in EndNote is 7 allows printing bibliographies by subject, which should be helpful 
in both these cases. 

Set display font size 
1. While in Edit Preferences, click on Display Fonts in the list on the left. 
2. Click both Change Fonts buttons and change font size to 10 and click Apply. 

Set columns to display 
1. While in Edit Preferences, click on Display Fields. 
2. In Column 4, select Record Number (or choose some other field). 
3. In Column 5, select a Custom field if you have added one and want to display it.  I show 

Competence in the display. 
4. Click OK. 

Sorting the library entries 
(See the EndNote help under the Contents tab for The Library Window heading, and The Library 
Window Sort Order topic.) 

1. In the main library window, click on the column name you want to sort on, and the library will 
appear sorted on that column. 

2. Click it again to reverse the sort order. 
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3. Entering Data Manually

Adding a new reference
Rules on author and editor names

General Rules
Using “et al.”, etc.
Anonymous works
Corporate authors
Complex author names

3. Entering Data Manually

 
There is a wealth of material in the online help under the Contents tab, Entering and Editing References 
heading.  Demonstrate this. 

To add a new reference to an open library: 
 

1. From the References menu, choose New Reference. This opens an empty Reference window. 
2. Choose a reference type from the Reference Type list at the top of the window. 
3. Enter bibliographic data into each of the fields in the Reference window. When you are finished, 

close the reference to save it and add it to the library.  
 
Copyright Thomson ISI 2003 

Rules on Entering Author & Editor Names 
The following information about Author and Editor fields applies to the following “Generic” field names: 
Author, Secondary Author, Tertiary Author, and Subsidiary Author. 

General rules 
 

• Author and editor names must be entered one name per line.  
• Author names can be entered either with the last name followed by a comma and the first name, 

or the first name followed by the last name. Both are correct but if you have the “Suggest Terms 
as You Type” feature turned on, EndNote suggests author names based on the assumption that the 
names are being entered with the last name first. 

• EndNote can abbreviate first and middle names, so for maximum flexibility enter whole names 
whenever possible. If you are entering initials instead of full names, be sure to type a period or a 
space between initials, (for example “Fisher, J.O.” or “J O Fisher”), otherwise EndNote interprets 
the initials as a single name: “Jo.”  
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Using “et al.” or Similar Abbreviations: 
Enter all author names for a particular reference. EndNote will truncate the list of authors with “et al.” or 
“and others” as required by the bibliographic style. If you do not know all of the authors’ names, then the 
last author should be “et al.” or “and others” followed by a comma. 

Anonymous Works: 
If a reference has no author, leave the Author field blank. The style that you use to format the 
bibliography determines how anonymous references are treated.   

Corporate Authors: 
When entering corporate authors, put a comma after the name. Be sure that you do not have any commas 
in the name because all text before the comma is interpreted as a last name.  
 
   U.S. Department of Agriculture,  
 
   Apple Computer Inc.,  

Complex Author Names: 
For multiple-word last names, like Charles de Gaulle, enter the name with the last name first, such as, "de 
Gaulle, Charles". 
 
Enter authors with titles, such as “Jr.” or “III”, as Last, First, Title. For example, “Alfred Smith 
Jr.” must be entered as, "Smith, Alfred, Jr."  See the Sorting section of the EndNote 
preferences if you do not want EndNote to include prepositions (such as de, van, von, etc.) when it 
alphabetizes references in a bibliography. 
 
Copyright Thomson ISI 2003 
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4. Importing Data

Chose an online database
Perform a search
Tag the records of interest
Click Export if it is available for direct import
Else click E-mail and import via a filter

4. Importing Data

 
• EndNote can connect directly to many online databases but you will be connecting via the 

University’s Library web site, which handles the authentication for you.  So you may not be able to 
use some of EndNote’s direct import features. 

• However, sites such as OCLC FirstSearch can export directly to EndNote. 
• Otherwise, you can email the selected records to yourself and EndNote can import them using one of 

its many filters. 

About EndNote’s Import Features 
The easiest way to build your EndNote library is to import the references from standard sources such as 
online bibliographic databases and library catalogs. EndNote can import references from many different 
sources and formats: 
 

• Online searching- EndNote can connect directly to many online databases. You can search the 
remote database and retrieve the references directly into EndNote. 

• Direct Export- Many web-based reference databases, including the BiomedNet Evaluated 
MEDLINE, ISI Current Contents Connect and Web of Science, and Ovid Technologies web 
databases, support direct downloading of selected references in EndNote-readable format. 

• CD-ROM and on-line  reference databases- EndNote can import references saved as text files 
from a variety of reference databases using customizable import filters. 

• Standard bibliographic formats- EndNote can import references from other bibliographic 
management programs, including Reference Manager and ProCite. 

• General-purpose databases- EndNote can import tab delimited or tagged files generated by 
standard database programs. 

 
Copyright Thomson ISI 2003 
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5. Searches

Sorting by column
Typing first letters of sorted column
<Ctrl>F or click ‘binocular’ icon
In Word, click ‘magnifying glass’ icon

5. Searches

 
Demonstrate these. 
 
EndNote search defaults to Any Field Contains <your search text>.  But you can also specify the database 
field and type of match, and you can add other search criteria.  Then you select one or more entries in 
EndNote, copy them to the clipboard (<Ctrl>C), switch to Word (<Alt>1) and paste them into Word 
(<Ctrl>V).  Click the Format Bibliography icon in the EndNote toolbar and choose the bibliography style 
you want to use (eg APA 5th). 
 
While you are in Word using “Cite While You Write”, you can click on the magnifying glass icon in the 
EndNote toolbar, and a different kind of dialog box pops up.  Highlight the reference you are searching 
for, and the citation will be inserted and formatted and bibliographic entry will be made automatically. 
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6. Advanced Topics

Custom fields
Customizing import filters
“Massaging” data files to conform to a filter 
format
Customizing output styles
Subject lists (new, not advanced)

6. Advanced Topics

Some of these topics are quite detailed and should be tried only after careful reading of the documentation 
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EndNote Resources
http://www.endnote.com/support/ensupport.asp
Website for this session

http://www.andrews.edu/leaderpart/RoundTable/Session2/p2/index.htm

Leadership Technology Toolkit
http://www.andrews.edu/leaderpart/toolkit.htm

Email dheise@andrews.edu
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